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Overview of ThePhotoStick® Omni 
 

ThePhotoStick® Omni is designed to easily back up and share all your photos, videos, documents, and audio files 

between all your devices.  It works on Windows, macOS, Android, and iOS/iPadOS devices.   

In this user guide, you will find sections for each major operating system (Windows/macOS/Android/iOS).  Each section 

provides detailed operating instructions and screenshots for that specific operating system. 
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System Requirements 
 

Microsoft Windows 
Windows 7 SP1, Windows 8, Windows 8.1, and Windows 10 

MacOS 
macOS 10.13 and later 

Android 
Version 6.0 (Marshmallow) and later 

iOS 
iOS and iPadOS 13.0 and later 
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Starting ThePhotoStick® Omni 
 

To start ThePhotoStick® Omni on Windows 
1) Plug ThePhotoStick® Omni into an open USB slot. 

2) From File Explorer, double-click on ThePhotoStick.exe. 

 

3) Once ThePhotoStick® Omni loads, follow the onscreen instructions. 

 



8 
 

To Start ThePhotoStick® Omni on Mac 
1) Plug ThePhotoStick® Omni into an open USB slot. 

2) Double-click on the desktop shortcut labeled as PHOTOSTICK. 

NOTE:  If no icon appears on your desktop after plugging in ThePhotoStick® Omni, go to Finder and 

double-click PHOTOSTICK listed under Devices/Locations. 

 
 

3) Double-click on ThePhotoStick_Mac. 
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4) Once ThePhotoStick® Omni loads, follow the onscreen instructions. 
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To Start ThePhotoStick® Omni on Android Devices 
1) Install the “ThePhotoStick Omni” app from the Google Play store.   

a. Open the Google play app on your Android device. 

b. Search for “ThePhotoStick Omni”. 
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c. Tap “Install” to install the app. 

 

d. Once the installation is complete, tap “Open” to start the app. 

 



12 
 

2) If prompted, tap “Allow” to allow ThePhotoStick Omni app to access your photos, videos, and audio files. 

 

3) Plug in your ThePhotoStick Omni device into your Android device. 

4) Tap “Get Started”. 
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To Start ThePhotoStick® Omni on iOS 
 

1) Install the “ThePhotoStick Omni” app from the App Store. 

a. Open the App Store on your iOS device. 

b. Search for “ThePhotoStick Omni”. 
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c. Tap “Get” and follow the prompts to install the app. 

 

d. Once the installation is complete, tap “Open” to start the app. 
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2) If prompted, tap “OK” to allow ThePhotoStick Omni app to access your photos and videos. 

 

3) If prompted, tap “OK” to allow ThePhotoStick Omni app to access your music files. 
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4) Plug in your ThePhotoStick Omni device into your iOS device.  Give your iPhone/iPad a few seconds to detect the 

drive, then proceed to step 5. 

5) Tap “Settings”. 

 

6) Tap on “PHOTOSTICK” and then tap “Done”. 
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7) Confirm your ThePhotoStick Omni device is detected.  Then, tap “Main Menu”. 

 

8) Tap “Backup Files Now!” 
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Using ThePhotoStick® Omni on Windows 

 

Getting to Know ThePhotoStick® Omni Interface 
 

 

 

 

Main menu — Allows for access to various features of ThePhotoStick® Omni, including your 
photos/videos/documents/audio settings, tools, and checking for ThePhotoStick® Omni software updates 

 
Status area — Provides status messages before, during, and after a backup is run. 

 

ThePhotoStick® Omni capacity chart — Provides a quick snapshot of how much used and free space is 
currently on your ThePhotoStick® Omni. 
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Additional Copy Options — Provides easy access to setting common copy options.  You can also access 
these settings by clicking on the “Options and Settings” button.   

 

Folder layout on ThePhotoStick® Omni — Choose the folder structure for files saved to your 
ThePhotoStick® Omni.  

 
Backup statistics — Provides information for your current backup. 

 

"Photo/Video Organizer" button — Opens ThePhotoStick® Omni Organizer that will show your photos, 
videos, documents, and audio files that are currently backed up to ThePhotoStick® Omni. 

 

"Options and Settings" button —Opens the Settings window for ThePhotoStick® Omni.  Here you can set 
which photo, video, document, and audio file types that ThePhotoStick® Omni will find and save as well as 
other application settings. 

 
"User Guide" button — Takes you to ThePhotoStick® Omni online user guide. 

 
"Exit" button —Closes ThePhotoStick® Omni application. 

 
"Go" button — Starts a backup of your photos, videos, documents, and audio files. 
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Getting to Know ThePhotoStick® Omni Backup Wizard Interface 
 

 

 

 

“Use Recommended Settings…” button — Choose to quickly start a backup with default and recommended 
settings. 

 

“Choose Your Own Settings…” button — Choose to have complete control on file types ThePhotoStick® 
Omni will find and save, as well as other backup settings. 

 

“Do Not Show On Startup” checkbox — Check the box if you do not want the Backup Wizard to start when 
first opening ThePhotoStick® Omni software.  You can always run the Backup Wizard by going to the Main 
menu and clicking on “Tools” → “Run Backup Wizard” 

 
Cancel button — Close the Backup Wizard without running it.   
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Starting a Backup 
ThePhotoStick® Omni offers a couple ways to start a backup of your photos and videos:  

1) The Backup Wizard 

2) The “Go” Button 

 

Starting a Backup with the Backup Wizard 
The Backup Wizard will walk you through starting a backup.  You can choose either to use the recommended settings or 

by choosing your own. 

By default, the Backup Wizard will open when you first run ThePhotoStick® Omni.  You can always run the Backup 

Wizard by going to the Main menu and clicking on “Tools” → “Run Backup Wizard” 

  

 

“Use Recommended Settings…” 
When you choose this option, the default settings for ThePhotoStick® Omni will be used during the backup. 

The default settings are: 

• Scans your entire C:\ drive 

• Looks for JPEG, HEIF, Photoshop, MOV, MPEG4, Word, Excel, PowerPoint, Works, MP3, and MPEG-4 file 

types  

• Skips duplicates and verify files 
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• Groups files by type (i.e. photos, videos, documents, and audio) 

• Excludes photos and videos smaller than 100 KB 

• Excludes document files smaller than 0 KB 

• Excludes audio files smaller than 800 KB 

 

To start, click on “Use Recommended Settings…” and then click on the “Go!” button: 
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“Choose Your Own Settings…” 
When you choose this option, you will be walked through picking where and what to find and save to your 

ThePhotoStick® Omni as well as customizing settings such as skipping duplicates. 

This option is ideal for situations where you have more than one hard drive in your computer, want to only scan 

directories that you choose, have additional photo, video, document, and audio file types to search for, etc. 

Here is an example of using the Backup Wizard to scan and save files from 2 hard drives, scan for additional photo, 

video, document, and audio types, as well as other setting changes. 
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Starting a Backup with the “Go” Button 
If you choose not to use the Backup Wizard, you can simply press the green “Go” button.  This will use the current 

settings and options that are configured in “Options and Settings”. 
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Viewing Files Saved to ThePhotoStick® Omni 
 

There are two ways you can view your photos, videos, documents, and audio files saved to ThePhotoStick® Omni: 

1) Viewing files using ThePhotoStick® Omni Organizer 

2) Viewing files using the Windows File Explorer 

 

Viewing Files Using ThePhotoStick® Omni Organizer Software 
ThePhotoStick® Omni Organizer offers an easy way to view and manager files saved to your ThePhotoStick® Omni. 

To open ThePhotoStick® Omni Organizer, click on the “Photo/Video Organizer” button: 
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ThePhotoStick® Omni Organizer will scan your ThePhotoStick® Omni drive for any new files and update the Gallery.  This 

will allow you to see photos, videos, documents, and audio files from all devices that backed up to your ThePhotoStick® 

Omni drive. 

    

 

ThePhotoStick® Omni Organizer will then open: 
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Viewing files With Your Computer's File Manager 
ThePhotoStick® Omni stores your photo, video, document, and audio files on your ThePhotoStick® Omni device in the 

directory path:  <ThePhotoStick® Omni device>\My_Files\<computer name>.   

For Windows computers, for example, if you plug your ThePhotoStick® Omni into a Windows computer and Windows 

assigns the drive letter E: to your ThePhotoStick® Omni device, the path to files backed up to it would be E:\My_Files. 

Then, within the My_Files folder, you will see a folder for each device that backed up files to your ThePhotoStick® Omni 

device. 
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Example screenshots from ThePhotoStick® Omni running on a Windows computer 
 

The following screenshots show the contents of a ThePhotoStick® Omni device that was used to back up files from 7 

different devices — 3 Android devices, 1 Windows desktop, 1 iPad, 1 Apple MacBook Pro, and 1 iPhone. 
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Options and Settings for ThePhotoStick® Omni 
 

Accessing Options and Settings 
To access ThePhotoStick® Omni's settings and options, open ThePhotoStick® Omni software and click on the "Options 

and Settings" button. 
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After clicking the "Options and Settings" button, the Settings window will appear: 

 

 

Where To Search 
By default, ThePhotoStick® Omni will recursively search all directory paths on your C:\ drive.  You can choose to change 

where ThePhotoStick® Omni searches, by checking and unchecking directories from the Devices and Drives list.  Once 

you make your selections, click the “Save” button. 
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For example, to have ThePhotoStick® Omni only search the “Users” folder on your C:\ drive and the “Camera Roll” folder 

on your E:\ drive, it will look like the following: 

 

 

What Photo and Video File Types To Find 
ThePhotoStick® Omni can find and save many types of photo and video files.  By default, ThePhotoStick® Omni will find 

and save JPEG, HEIF, Photoshop, MOV, and MPEG4 files.  But, it can find and save many more photo and video file types 

if you choose.   
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To change or add additional photo and video file types to find and save, click on the "What Photo/Video File Types To 

Find" tab, and then check the box next to the photo and video file types you would like ThePhotoStick® Omni to find and 

save.   Click "Save" to save.     

 

 

Document and Audio File Types To Find 
ThePhotoStick® Omni can find and save many types of document and audio files.  By default, ThePhotoStick® Omni will 

find and save Microsoft Word, Excel, PowerPoint, and Works document files and MP3 and MPEG-4 audio files.  But, it 

can find and save many more document and audio file types if you choose.  
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To change or add additional document and audio file types to find and save, click on the "What Document/Audio File 

Types To Find” tab, and then check the box next to the document and audio file types you would like ThePhotoStick® 

Omni to find and save.   Click "Save" to save. 
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Other Options 
ThePhotoStick® Omni has additional backup options available.  These can be accessed by clicking on the "Other Options" 

tab, making any option changes, and then clicking the "Save" button to save. 

 

 

Additional Copy Options 

 

Verify Files 
When this box is checked, ThePhotoStick® Omni will verify each file it saves to your ThePhotoStick® Omni device.  It does 

this by comparing the file it just saved to your ThePhotoStick® Omni device with the original file on your computer.  This 

is a recommended setting. 

 

Skip Duplicates 
Often times, the same photos and videos (or document and audio files on ThePhotoStick® Omni Plus) can be saved in 

various places on your hard disk drive.  When the "Skip Duplicates" box is checked, it will result in only one copy of that 

file being copied to ThePhotoStick® Omni.  If you uncheck this option and ThePhotoStick® Omni finds a duplicate file, it 

will copy the duplicate file to ThePhotoStick® Omni and rename it on ThePhotoStick® Omni to {filename}_copy-# 

(example: DSCF0566_copy-1.JPG). 
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Create Thumbnails 
When this box is checked, thumbnail images of your photos and videos will be created at the time the files are saved to 

your ThePhotoStick® Omni. 

When you view your photos and videos in ThePhotoStick® Omni Organizer, it displays thumbnails of the photos and 

videos. If the thumbnails have already been created during the backup, the thumbnails will load very quickly in the 

ThePhotoStick® Omni Organizer software. 

However, if you choose to not create thumbnails during the backup, the backup of the photos and videos can be faster.  

But the ThePhotoStick® Omni Organizer will take longer to load all the thumbnail images of your photos and videos since 

they have to be created at that time. 

 

Overwrite Files 
When this box is checked, if a file being saved to your ThePhotoStick® Omni device already exists on your 

ThePhotoStick® Omni device, the file on your ThePhotoStick® Omni device will be deleted and replaced with a new copy 

of the file from your computer. 

 

Folder Layout on ThePhotoStick® Omni 
 

Group Files By Type 
When you select the button next to "Group Files By Type (i.e. photos and videos)", ThePhotoStick® Omni will consolidate 

your photos, videos, documents, and audio files on ThePhotoStick® Omni into folders for easy and convenient access.  

ThePhotoStick® Omni stores your photos, videos, documents, and audio files on your ThePhotoStick® Omni in the folder:  

{ ThePhotoStick® Omni drive}\My_Files\{computer name>}. 

For example, if you plug your ThePhotoStick® Omni into a Windows computer and Windows assigns the drive letter E: to 

your ThePhotoStick® Omni device, the path to files backed up to it would be E:\My_Files. 

Within the My_Files folder, you will see a folder for each device that backed up files to your ThePhotoStick® Omni 

device.  Then, in this folder, you will see the folders My_Photos, My_Videos, My_Documents, and My_Audio.  So, for 

example, the path to your consolidated photos would be E:\My_Files\LAPTOP-12V875\My_Photos.  And the path to 

your videos would be E:\My_Files\LAPTOP-12V875\My_Videos. 

 

Keep Your Folder Layout 
When you select the button next to "Keep your folder layout", ThePhotoStick® Omni will save your photos, videos, 

documents, and audio files using the same folder structure as on your computer starting in {ThePhotoStick® Omni 

drive}\My_Files\{computer name>}. 
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For example, you plug your ThePhotoStick® Omni into a computer that has two drives, C:\ and D:\.  The computer's 

name is LAPTOP-12V875, and Windows assigns the drive letter E: to your ThePhotoStick® Omni device. The files saved to 

your ThePhotoStick® Omni would be like the following: 

  Original File Path on Hard Drive   File Path to Saved File on ThePhotoStick® Omni 

  C:\photos\DSCF0566.JPG   E:\My_Files\LAPTOP-12V875\C\photos\DSCF0566.JPG 

  C:\Users\ricky\pictures\IMG_1024.JPG    E:\My_Files\LAPTOP-12V875\C\Users\ricky\pictures\IMG_1024.JPG 

  C:\Users\ricky\pictures\vacation_2019\02032019.mp4   E:\My_Files\LAPTOP-12V875\C\Users\ricky\pictures\vacation_2019\02032019.mp4 

  D:\photos\IMG_8567.heic   E:\My_Files\LAPTOP-12V875\D\photos\IMG_8567.heic 

 

Exclude Files 
 

Exclude Photo/Video files smaller than 
By default, ThePhotoStick® Omni will skip and not save any photos or videos smaller than 100 KB.  Generally, any picture 

or video files smaller than 100 KB are system or application images and not user photos or videos.  This value can be 

adjusted to any size that you prefer.  For example, if you want all photo and video files saved no matter how small they 

are, you can change the value to "0".  Likewise, if you know your photos are all bigger than 2 MB (the approximate size 

of an 8-megapixel camera), you can change this exclude value to 2 MB.  Click the "Save" button to save changes. 

Exclude Documents files smaller than  

By default, ThePhotoStick® Omni Plus will save all document files no matter how small they are.  You can change this to 

exclude documents under a certain size to fine tune your documents backup. 

Exclude Audio files smaller than  

By default, ThePhotoStick® Omni Plus will skip audio files smaller than 800 KB.  This value can be adjusted to any size 

that you prefer.  For example, if you want all audio files saved no matter how small they are, you can change the value 

to "0".  Likewise, if you know your audio files are all bigger than 3 MB (the average size of an mp3 song is 3.5 MB), you 

can change this exclude value to 3 MB and fine tune the audio file backup.   

Click the "Save" button to save changes. 
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Using ThePhotoStick® Omni on Mac Computers 
 

Getting to Know ThePhotoStick® Omni Interface 
 

 

 

 

Used Space on your ThePhotoStick® Omni device — Graphical view of how much space is used on your 
ThePhotoStick® Omni device. 

 

ThePhotoStick Device Summary — Provides the total number of photos, videos, documents, and audio files 
saved on your ThePhotoStick® Omni device as well as the remaining space available on the ThePhotoStick® 
Omni device. 

 

ThePhotoStick Device Usage Details — Provides a breakdown of what exactly is saved on your 
ThePhotoStick® Omni device.  Here you can easily see how many files of each file type are saved to your 
ThePhotoStick® Omni as well as how much space those files are using on your ThePhotoStick® Omni device.   

 

“Refresh” button — Refreshes the “ThePhotoStick Device Usage Details” by rescanning your 
ThePhotoStick® Omni device.  
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“Backup” button — Open the backup window.  Here you can start a backup with your chosen backup 
preferences.  

 

"Photo/Video Organizer" button — Opens ThePhotoStick® Omni Organizer that will show your photos, 
videos, documents, and audio files that are currently backed up to ThePhotoStick® Omni. 

 

"Tools and Utilities" button — Opens the tools and utilities for ThePhotoStick® Omni.  Here you can 
remove all saved files on your ThePhotoStick® Omni or reset your ThePhotoStick® Omni to factory defaults. 

 
"User Guide" button — Takes you to ThePhotoStick® Omni online user guide. 

 

"Backup Preferences" button —Opens the backup preferences for ThePhotoStick® Omni.  Here you can set 
which photo, video, document, and audio file types that ThePhotoStick® Omni will find and save as well as 
other application settings. 

 

Starting a Backup 
 

To start a backup, click on the “Backup” button and then “Start Backup Now”.  If you did not change any backup 

preferences, the default backup settings are used.   

The default settings are: 

• Scans /Users folder 

• Looks for JPEG, HEIF, Photoshop, MOV, MPEG4, Word, Excel, PowerPoint, Works, Writer, Impress, Calc, 

Draw, Math, Base, MP3, and MPEG-4 file types  

• Skips Duplicates and Verify Files 

• Groups files by type (i.e. photos, videos, documents, and audio) 

• Excludes photos and videos smaller than 100 KB 

• Excludes document files smaller than 0 KB 

• Excludes audio files smaller than 800 KB 
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Viewing Files Saved to ThePhotoStick® Omni 
 

There are two ways you can view your photos, videos, documents, and audio files saved to ThePhotoStick® Omni: 

1) Viewing files using ThePhotoStick® Omni Organizer 

2) Viewing files using the macOS Finder application 

 

Viewing Files Using ThePhotoStick® Omni Organizer Software 
ThePhotoStick® Omni Organizer offers an easy way to view and manager the files saved to your ThePhotoStick® Omni. 

To open ThePhotoStick® Omni Organizer, click on the “Photo/Video Organizer” button: 
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ThePhotoStick® Omni Organizer will then open: 

 

Viewing Files With the macOS Finder Application 
ThePhotoStick® Omni stores your photo, video, document, and audio files on your ThePhotoStick® Omni device in the 

directory path:  <ThePhotoStick® Omni device>/My_Files/<computer name>.   

So, on your Mac computer, the path to files backed up on your ThePhotoStick® Omni device would be 

/Volumes/PHOTOSTICK/My_Files. 

Then, within the My_Files folder, you will see a folder for each device that backed up files to your ThePhotoStick® Omni 

device. 
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Example screenshots from ThePhotoStick® Omni running on a MacBook Pro computer 
 

Open Finder on your Mac computer, click on your ThePhotoStick® Omni device, and then open the My_Files folder. 
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The following screenshots show the contents of a ThePhotoStick® Omni device that was used to back up files from 7 

different devices — 3 Android devices, 1 Windows desktop, 1 iPad, 1 Apple MacBook Pro, and 1 iPhone.   

As an example, the following screenshots show viewing files saved from the MacBook Pro computer named “Monty’s 

MacBook Pro”.   
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Backup Preferences for ThePhotoStick® Omni 
 

Accessing Backup Preferences 
To access ThePhotoStick® Omni's Backup Preferences, open ThePhotoStick® Omni software and click on the "Backup 

preferences" button. 
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ThePhotoStick will recursively search any folder paths specified in its settings.  By default, ThePhotoStick® Omni will start 

at “/Users" on Mac computers.   

 

Where To Search 
 

Adding a Folder Path to Scan 
You can add additional search paths by clicking on the "Add..." button, browsing to and selecting the folder you would 

like to recursively search, then clicking "Choose".  You should now see the path added in the list of folders to scan.  Click 

"Save" to save. 

For example, if you would like ThePhotoStick® Omni to also recursively search the folder 

“/Users/montyp/Pictures/vacation 2020”, do the following.  

Note: Since the /Users folder is already in the scan for files list, the vacation 2020 folder will already be scanned.  

But, it is being used to demonstrate how to select other folders to scan if desired.  
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Removing a Folder Path to Scan 
To remove a folder path to scan, select the folder path in the list, then click on "Remove Selected".  

Note: You can select multiple folder paths at the same time by holding down the Apple Command ⌘ 
           key when clicking on another folder path. 

To continue the example from the previous section, if you do not want your ThePhotoStick® Omni device to search your 

entire /Users folder and instead only search the “/Users/montyp/Pictures/vacation 2020” folder, you can remove 

"/Users" by selecting it and then clicking "Remove Selected".  Then, click the "Save" button to save settings. 
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Adding a Folder Path to Skip 
You can add additional folder paths to be skipped and ignored by clicking on the "Add..." button, browsing to and 

selecting the folder you would like to skip, then clicking "Choose".  The folder you selected, plus any subfolders in that 

folder will be skipped.  You should now see the path added in the list of folders to skip.  Click "Save" to save settings. 

For example, if you want your ThePhotoStick® Omni to scan your entire /Users folders but skip searching the Downloads 

folder, you can click the "Add..." button under the "Folders to skip:" section and add the Downloads folder as shown in 

the screenshots below: 
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Removing a Folder Path to Skip 
To remove a directory path to skip, select the folder path in the list, then click on "Remove Selected".   

Note: You can select multiple folder paths at the same time by holding down the Apple Command ⌘ 
           key when clicking on another folder path. 

For example, if you do not want ThePhotoStick® Omni to skip the "/Application" folder, you can remove "/Application" 

by selecting it and then clicking "Remove Selected".  Click "Save" to save settings. 
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What Photo and Video File Types To Find 
ThePhotoStick® Omni can find and save many types of photo and video files.  By default, ThePhotoStick® Omni will find 

and save JPEG, HEIF, Photoshop, MOV, and MPEG4 files.  But, it can find and save many more photo and video file types 

if you choose.   

To change or add additional photo and video file types to find and save, click on the "What Photo/Video File Types To 

Find" tab, and then check the box next to the photo and video file types you would like ThePhotoStick® Omni to find and 

save.   Click "Save" to save.     

 

Document and Audio File Types To Find 
ThePhotoStick® Omni can find and save many types of document and audio files.  By default, ThePhotoStick® Omni will 

find and save Microsoft Office (Word, Excel, PowerPoint), Microsoft Works, and OpenOffice/LibreOffice (Writer, 

Impress, Calc, Draw, Math, Base) document files.  Also, by default, MP3 and MPEG-4 audio files.  But, it can find and save 

more document and audio file types if you choose.  
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To change or add additional document and audio file types to find and save, click on the "What Document/Audio File 

Types To Find” tab, and then check the box next to the document and audio file types you would like ThePhotoStick® 

Omni to find and save.   Click "Save" to save. 
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Other Options 
ThePhotoStick® Omni has additional backup options available.  These can be accessed by clicking on the "Other Options" 

tab, making any option changes, and then clicking the "Save" button to save. 

 

 

Additional Copy Options 

 

Verify Files 
When this box is checked, ThePhotoStick® Omni will verify each file it saves to your ThePhotoStick® Omni device.  It does 

this by comparing the file it just saved to your ThePhotoStick® Omni device with the original file on your computer.  This 

is a recommended setting. 

 

Skip Duplicates 
Often times, the same photos and videos (or document and audio files on ThePhotoStick® Omni Plus) can be saved in 

various places on your hard disk drive.  When the "Skip Duplicates" box is checked, it will result in only one copy of that 

file being copied to ThePhotoStick® Omni.  If you uncheck this option and ThePhotoStick® Omni finds a duplicate file, it 

will copy the duplicate file to ThePhotoStick® Omni and rename it on ThePhotoStick® Omni to {filename}_copy-# 

(example: DSCF0566_copy-1.JPG). 
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Create Thumbnails 
When this box is checked, thumbnail images of your photos and videos will be created at the time the files are saved to 

your ThePhotoStick® Omni. 

When you view your photos and videos in ThePhotoStick® Omni Organizer, it displays thumbnails of the photos and 

videos. If the thumbnails have already been created during the backup, the thumbnails will load very quickly in the 

ThePhotoStick® Omni Organizer software. 

However, if you choose to not create thumbnails during the backup, the backup of the photos and videos can be faster.  

But the ThePhotoStick® Omni Organizer will take longer to load all the thumbnail images of your photos and videos since 

they have to be created at that time. 

 

Overwrite Files 
When this box is checked, if a file being saved to your ThePhotoStick® Omni device already exists on your 

ThePhotoStick® Omni device, the file on your ThePhotoStick® Omni device will be deleted and replaced with a new copy 

of the file from your computer. 

 

Folder Layout on ThePhotoStick® Omni 
 

Group Files By Type 
When you select the button next to "Group Files By Type (i.e. photos and videos)", ThePhotoStick® Omni will consolidate 

your photos, videos, documents, and audio files on ThePhotoStick® Omni into folders for easy and convenient access.  

ThePhotoStick® Omni stores your photos, videos, documents, and audio files on your ThePhotoStick® Omni in the folder:  

{ ThePhotoStick® Omni drive}/My_Files/{computer name>}. 

So, on your Mac computer, the path to files backed up on your ThePhotoStick® Omni device would be 

/Volumes/PHOTOSTICK/My_Files. 

Within the My_Files folder, you will see a folder for each device that backed up files to your ThePhotoStick® Omni 

device.  Then, in this folder, you will see the folders My_Photos, My_Videos, My_Documents, and My_Audio.   

So, for example, the path to your consolidated photos from a computer that was named LAPTOP-12V875, it would be 

/Volumes/PHOTOSTICK/My_Files/LAPTOP-12V875/My_Photos.  And the path to your videos would be 

/Volumes/PHOTOSTICK/My_Files/LAPTOP-12V875/My_Videos. 

 

Keep Your Folder Layout 
When you select the button next to "Keep your folder layout", ThePhotoStick® Omni will save your photos, videos, 

documents, and audio files using the same folder structure as on your computer starting in {ThePhotoStick® Omni 

drive}/My_Files/{computer name>}. 
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For example, for files backed up to your ThePhotoStick® Omni device from a computer that is named LAPTOP-12V875, 

the files saved to your ThePhotoStick® Omni would be like the following: 

  Original File Path on Hard Drive   File Path to Saved File on ThePhotoStick® Omni 

  /photos/DSCF0566.JPG /Volumes/PHOTOSTICK/My_Files/LAPTOP-12V875/photos/DSCF0566.JPG 

  /Users/ricky/pictures/IMG_1024.JPG  /Volumes/PHOTOSTICK/My_Files/LAPTOP-12V875/Users/ricky/pictures/IMG_1024.JPG 

  /Users/ricky/pictures/vacation_2019/02032019.mp4 
/Volumes/PHOTOSTICK/My_Files\LAPTOP-
12V875/Users/ricky/pictures/vacation_2019/02032019.mp4 

  /photos/IMG_8567.heic /Volumes/PHOTOSTICK/My_Files/LAPTOP-12V875/photos/IMG_8567.heic 

 

Exclude Files 
 

Exclude Photo/Video files smaller than 
By default, ThePhotoStick® Omni will skip and not save any photos or videos smaller than 100 KB.  Generally, any picture 

or video files smaller than 100 KB are system or application images and not user photos or videos.  This value can be 

adjusted to any size that you prefer.  For example, if you want all photo and video files saved no matter how small they 

are, you can change the value to "0".  Likewise, if you know your photos are all bigger than 2 MB (the approximate size 

of an 8-megapixel camera), you can change this exclude value to 2 MB.  Click the "Save" button to save changes. 

Exclude Documents files smaller than  

By default, ThePhotoStick® Omni Plus will save all document files no matter how small they are.  You can change this to 

exclude documents under a certain size to fine tune your documents backup. 

Exclude Audio files smaller than  

By default, ThePhotoStick® Omni Plus will skip audio files smaller than 800 KB.  This value can be adjusted to any size 

that you prefer.  For example, if you want all audio files saved no matter how small they are, you can change the value 

to "0".  Likewise, if you know your audio files are all bigger than 3 MB (the average size of an mp3 song is 3.5 MB), you 

can change this exclude value to 3 MB and fine tune the audio file backup.   

Click the "Save" button to save changes. 
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Using ThePhotoStick® Omni on Android Devices 
 

Installing ThePhotoStick Omni App 
1) Open the Google play app on your Android device. 

2) Search for “ThePhotoStick Omni”. 
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3) Tap “Install” to install the app. 

 

4) Once the installation is complete, tap “Open” to start the app. 
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5) If prompted, tap “Allow” to allow ThePhotoStick® Omni app to access your photos, videos, and audio files. 

 

6) Plug in your ThePhotoStick® Omni device into your Android device. 
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Getting to Know ThePhotoStick® Omni Android App Interface 
 

 

 

“Get Started” button— Tap to start a backup, view, and/or restore files to and from your ThePhotoStick® 
Omni device.  

 

“Tutorial” button — Tap to view the in-app tutorial.  This provides a walk-through of the ThePhotoStick® 
Omni app and how to use it. 

 
“Online Help” button — Tap to view the full and detailed user guide for ThePhotoStick® Omni. 

 
“Unmount USB” button — Tap to safely eject ThePhotoStick® Omni device from your phone or tablet. 
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Starting a Backup 
1) Ensure your ThePhotoStick® Omni device is plugged into your phone or tablet, then tap “Get Started”. 
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2) Select your ThePhotoStick® Omni device by tapping the button with the three horizontal bars in the top left-

hand corner of your phone’s screen. 

 

3) Select the PHOTOSTICK option in the list that appears.  (Note: On some phones and tablets, it may show as a 

"generic usb device" and not say "PHOTOSTICK"). 
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4) Tap "Use this Folder" located at the bottom of the screen. 

 

 
 

5) Tap "Allow" to grant access to ThePhotoStick® Omni USB drive 
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NOTE: Select ALLOW, otherwise the app will not have access to the ThePhotoStick® Omni connected 

to your mobile device. 

After selecting your ThePhotoStick® Omni device, you will see the Backup, View, and Restore screen.  It loads, by default, 

with the “Backup” tab selected and shows the main Backup menu.  

You have three backup options.  You can select individual photos/videos/audio files to back up, back up all 

photos/videos/audio files with a single tap, or back up photos from your Facebook account. 
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Select From Storage 
 

1) Tap the “Select From Storage” button 

 

  
 

 

A new window will appear containing a gallery of all media on your phone.  At the top of the page, you will see 

sorting options as well as the close button.  At the bottom of the page, you can tap “Clear” to deselect any 

media you have selected or “Select All” to select all media on your phone.     
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2) Select the photos/videos/audio files you want to save to your ThePhotoStick® Omni, then tap the “Backup” 

button to start the backup. 
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3) Once a backup begins, you will be taken to the running backup screen where you can monitor the progress of 

the backup. 
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4) Once the backup completes, you will see a message indicating the backup is complete.  Tap “Done”.   

NOTE:  Only tap the “Done” button once the activity light on the ThePhotoStick® Omni device stops 

flashing.     

 

5) You will be taken back to the backup select screen in case you want to back up more media files.  If not, tap the 

red close button to return to the backup menu. 

  



77 
 

 

Backup All Media 
 

1) Tap the “Backup All Media” 

 

2) The backup of all your photos, videos, and audio files will immediately start. 
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3) Once the backup completes, you will see a message indicating the backup is complete.  Tap “Done”.   

NOTE:  Only tap the “Done” button once the activity light on the ThePhotoStick® Omni device stops 

flashing.     

 

4) You will be taken back to the backup select screen in case you want to back up more media files.  If not, tap the 

red close button to return to the backup menu. 
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Backing Up Your Facebook Photos 
 

1) Tap on the “Continue with Facebook” button. 

 

2) Log into Facebook with your Facebook credentials. 

 



80 
 

3) If prompted, tap the “Continue as” button. 

 

4) After successfully logging into Facebook, you will see a list of Facebook categories containing your Facebook 

photos.  To view your photos, tap on the different categories.  In this example, we will tap on “Timeline Photos”. 
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5) Select the photos you want to back up to your ThePhotoStick® Omni, then tap “Backup” 

 

6) Once a backup begins, you will be taken to the running backup screen where you can monitor the progress of 

the backup. 
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7) Once the backup completes, you will see a message indicating the backup is complete.  Tap “Done”.   

NOTE:  Only tap the “Done” button once the activity light on the ThePhotoStick® Omni device stops 

flashing.     

 

8) You will be taken back to the Facebook backup select screen in case you want to back up more media files.  If 

not, tap the red close button to return to the backup menu. 

NOTE:  Now that you are logged into Facebook, the backup menu now shows a button called “Backup 

From Facebook”.  You stay logged into Facebook, or if you prefer, you can log out of Facebook by 

tapping “Log Out”. 
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Viewing Files Saved to ThePhotoStick® Omni 
You can view the files on your ThePhotoStick® Omni device by either viewing them in the ThePhotoStick® Omni app or 

on your PC or Mac computer. 

To view them in the ThePhotoStick® Omni app, do the following: 

1) From the Backup, View, and Restore screen, tap on the “View” tab. 
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2) If you want to view a larger version of a photo, tap on it.  To play a video, tap on the video and it will start 

playing. 
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Deleting Selected Files From ThePhotoStick® Omni device 
 

You can delete media files from the View tab by tapping and holding down on a thumbnail until a checkmark appears in 

the top right-hand corner of the thumbnail, then selecting the Delete button that appears at the bottom of the screen. 
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Restoring Photos, Videos, and Audio Files 
You have two restore options.  You can select individual photos/videos/audio files to restore to your mobile device, or 

you can choose to restore all photos/videos/audio files with a single tap. 

 

Select To Restore 
 

1) From the Backup, View, and Restore screen, tap on the “Restore” tab. 
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2) Tap the “Select to Restore” button 

 

  
 

3) Select the photos/videos/audio files you want to restore to your mobile device, then tap the “Restore” button to 

start the restore. 
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4) Once a restore begins, you will be taken to the running restore screen where you can monitor the progress of 

the restore. 
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5) Once the restore completes, you will see a message indicating the restore is done.  Tap “Done”.   

NOTE:  Only tap the “Done” button once the activity light on the ThePhotoStick® Omni device stops 

flashing.     

 

6) You will be taken back to the restore select screen in case you want to restore more media files.  If not, tap the 

red close button to return to the restore menu. 
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NOTE:  ThePhotoStick® Omni restores files to an album called “ThePhotoStick” in your Photo Gallery 

app.  It can take a minute for your phone to register it has new files to display in its Photo Gallery app. 

 

The Photo Gallery app varies depending on your phone’s manufacturer, Android OS version, etc.  See 

your phone’s Photo Gallery app user guide for any assistance.   
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Restore All Media on ThePhotoStick® Omni 
 

1) From the Backup, View, and Restore screen, tap on the “Restore” tab. 
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7) Tap the “Restore All” button 

 

  

 

3) The restore to your mobile device of all your photos, videos, and audio files that are on your ThePhotoStick® 

Omni device will immediately start. 
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8) Once the restore completes, you will see a message indicating the restore is done.  Tap “Done”.   

NOTE:  Only tap the “Done” button once the activity light on the ThePhotoStick® Omni device stops 

flashing.     

 

9) You will be taken back to the restore select screen in case you want to restore more media files.  If not, tap the 

red close button to return to the restore menu. 
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NOTE:  ThePhotoStick® Omni restores files to an album called “ThePhotoStick” in your Photo Gallery 

app.  It can take a minute for your phone to register it has new files to display in its Photo Gallery app. 

 

The Photo Gallery app varies depending on your phone’s manufacturer, Android OS version, etc.  See 

your phone’s Photo Gallery app user guide for any assistance.   
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Using ThePhotoStick® Omni on iPhone/iPad 
 

Installing ThePhotoStick Omni App 
1) Open the App Store app on your iPhone/iPad. 

2) Search for “ThePhotoStick Omni”. 
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3) Tap “Get” to install the app. 

 

4) Once the installation is complete, tap “Open” to start the app. 
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5) If prompted, tap “OK” to allow ThePhotoStick® Omni app to access your photos. 

 

6) If prompted, tap “OK” to allow ThePhotoStick® Omni app to access your music files. 
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7) Plug in your ThePhotoStick® Omni device into your iPhone/iPad. 
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8) Wait for 5 seconds to give your iPhone or iPad time to discover your ThePhotoStick® Omni device.  Then, tap 

"Settings". 

 

9) Select "PHOTOSTICK" (NOTE: do not select any folders under PHOTOSTICK), then tap "Done". 
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10) Ensure that ThePhotoStick® Omni device is now detected and then tap "Main Menu". 

 

11) You will now be at the main screen: 
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Getting to Know ThePhotoStick® Omni iPhone/iPad App Interface 
 

 

 
Takes you to the backup options: “Backup All Photos, Videos, Music” or “Select to Backup”. 

 
Displays files that are currently on your ThePhotoStick® Omni device. 

 
Takes you to the restore options: “Restore All Photos and Videos” or “Select to Restore”. 

 
Displays instructions on how to empty the Recently Deleted Album on iOS devices. 

 
Displays detailed instructions on using your ThePhotoStick® Omni app. 
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Starting a Backup 
1) If the ThePhotoStick® Omni device is not plugged into your iPhone or iPad, do it now.  Then, from the main app 

screen, tap on “Backup Files Now!” 

 

2) From the backup menu, choose either “Backup All Photos, Videos, Music” or “Select to Backup”. 
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Tapping “Backup All Photos, Videos, Music” will immediately begin a backup of all your photos, 
videos, and music files (NOTE: music files must be downloaded from iTunes to your 
iPhone/iPad). 

 

Tapping “Select to Backup” will bring you to another screen where you can select specific 
photos, videos, and music files to back up to your ThePhotoStick® Omni device. 

 

3) If you selected "Select to Backup", tap on any photos, videos, and music files you want to save to your 

ThePhotoStick® Omni device.  To help you find the files you want to save, you can choose to display all photos 

and videos, just photos, just videos, or just music by tapping on the category buttons in the bottom toolbar.  

When ready to start saving the selected photos and videos to your ThePhotoStick® Omni device, tap "Backup 

Now!" 
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4) Once a backup begins, you will be taken to the running backup screen where you can monitor the progress of 

the backup. 

 

5) Once the backup completes, you will see the backup summary status screen. 
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The number of photos/videos/music files that were successfully backed up. 

 

Tap this button to view photos/videos/music files on your ThePhotoStick® Omni device.  We highly 
recommend doing this at this stage to ensure that all the photos, videos, and music files you backed up are 
on the ThePhotoStick® Omni device. 

 

Remove photos and videos from your iPhone or iPad that were just saved to your ThePhotoStick® Omni 
device. ** 

 
Go back to the main menu. 

** iPhones and iPads do not permanently remove photos and videos after deleting them. To immediately free 

up space on your iPhone or iPad, go to Photos, then Albums, then choose the “Recently Deleted” album. Delete 

the photos and videos in this album to free up space that the deleted photos/videos are using. 

6) If you tap the “Remove Backed up files from phone” button, you will be prompted to be sure you want to 

remove those photos and/or videos from your iPhone or iPad. If you are sure, tap “Yes”. 
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7) You will be asked to confirm again if you want to remove those photos and/or videos. If you are sure, tap 

“Delete.” 

 

8) Tap “OK” on the removal confirmation pop-up message when removal is complete. 

Note: iPhones and iPads do not permanently remove photos and videos after deleting them. To 

immediately free up space on your iPhone or iPad, go to Photos, then Albums, then choose the 

“Recently Deleted” album. Delete the photos and videos in this album to free up space that the 

deleted photos/videos are using. This is not a required step and only needed if you need to free up 

space immediately on your iPhone or iPad. 
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Viewing Files Saved to ThePhotoStick® Omni 
You can view the files on your ThePhotoStick® Omni device by either viewing them in the ThePhotoStick® Omni app or 

on your PC or Mac computer. 

To view them in the ThePhotoStick® Omni app, do the following: 

1) From the main app screen, tap “View Files On Your ThePhotoStick.” 
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2) If you want to view a larger version of a photo, tap on it.  To play a video, tap on the video and it will start 

playing. 
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Restoring Photos and Videos 
 

Due to Digital Rights Management (DRM), music files cannot be directly restored to your iPhone or 

iPad.  You must use Apple’s iTunes app to re-download any music files you have purchased.  

1) From the main app screen, tap “Restore Files”. 
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2) From the restore menu, chose either “Restore All Photos and Videos” or “Select to Restore”. 

 

 

 

Tapping “Restore All Photos and Videos” will immediately begin to copy all of the photos and 
videos on ThePhotoStick® Omni device to your iPhone or iPad. 

 

Tapping “Select to Restore” will bring you to another screen where you can select specific 
photos and videos to be restored to your ThePhotoStick® Omni device. 

 

3) If you choose “Select to Restore,” you will be taken to the screen where you can select the photos and videos to be 

restored to your iPhone or iPad.  To help you find the photos you want to restore, you can choose to display all 

photos and videos, just photos, or just videos by tapping on the category buttons in the bottom toolbar.  When 

ready to start restoring the selected photos and videos, tap "Restore Now!" 
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4) Once a restore begins, you will be taken to the running restore screen where you can monitor the progress of the 

restore. 
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5) Once the restore completes, you will see the restore summary status screen. 
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Troubleshooting the ThePhotoStick® Omni iOS app  
 

If you are unable to run a backup or view/restore photos and videos, please follow the steps below. 

Common causes of not being able to run a backup or view/restore photos and videos 
1) ThePhotoStick® Omni device is not fully plugged into or your iPhone or iPad 

2) ThePhotoStick® Omni was left plugged into your iPhone or iPad when not being used and iOS put ThePhotoStick® 

Omni device to sleep. 

3) ThePhotoStick® Omni app needs to be closed and re-opened. 

 

Steps to resolve the issue: 

Try one or more of the following suggestions: 

1) Ensure your ThePhotoStick® Omni device is plugged in fully and securely into your iPhone or iPad. 

Some phone cases for iPhones and iPads may be too thick and may prevent the drive from being fully plugged 

in. Try plugging the ThePhotoStick® Omni device in without the iPhone or iPad case on to see if the drive can 

fully plug in. 

2) Unplug and plug back in your ThePhotoStick® Omni device. 

• Remove your ThePhotoStick® Omni device from your iPhone or iPad. 

• Wait 5 seconds. 

• Plug your ThePhotoStick® Omni device back into your iPhone or iPad. 

• Wait 5-10 seconds for your iPhone or iPad to detect your ThePhotoStick® Omni device. 

• Go to Settings by tapping on the gear icon in the app. 
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• Tap the "Select Your ThePhotoStick Device" button. 

 

• Select "PHOTOSTICK" (NOTE: do not select any folders under PHOTOSTICK), then tap "Done". 
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3) Check if Apple's "Files" app can see your ThePhotoStick® Omni device. 

• From the Home Screen, tap on “Files” 

 

• Under the "Locations" section you should see "PHOTOSTICK". 
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If you do not see this, then your iPhone or iPad does not detect the ThePhotoStick® Omni device. 

 

4) Try powering off and back on your iPhone or iPad. 

• Hold the power button on your iPhone or iPad until the power off slider appears. 

• Drag the slider to power off and then wait 30 seconds for the iPhone or iPad to power off. 

• Turn the iPhone or iPad back on by pressing and holding the power button until you see the Apple logo. 

• After powering back up, ensure ThePhotoStick® Omni device is plugged in fully and securely and see if it is 

now seen in the "Files" and ThePhotoStick® Omni app. 

 

5) Close and re-open ThePhotoStick® Omni app. 

• On iPhone 8 or earlier, double-click the Home button to show the currently open apps on your iPhone or 

iPad. 

• On iPhone X and later or iPad with iOS 12 or later, from the Home screen, swipe up from the bottom of the 

screen and pause slightly in the middle of the screen.  

• Then, Swipe left or right to find ThePhotoStick® Omni app and then swipe up on it to close the app. 

• To open the ThePhotoStick® Omni app again, find the app on your Home screen and then tap to open it. 
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Common causes of not being able to run a backup of music files 
 

Due to Digital Rights Management (DRM), only music downloaded and saved locally on your iPhone or iPad can be 

backed up.  So, be sure to download any purchased songs from iTunes if you want them saved to your ThePhotoStick® 

Omni device. 


